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1 Introduction

1.1 Abbreviations and acronyms

JMMC Jean-Marie Mariotti Center

SearchCal The Search Calibrators tool

JSDC JMMC Stellar Diameters Catalogue

CDS Centre de Donnees Astronomiques de Strasbourg

IVOA International Virtual Observatory Alliance

1.2 Presentation

Few software tools are available to help the astronomer find good calibrators for optical interferometry
observations. SearchCal is both a server-side software that dynamically builds a catalog of stars with all
useful information for the selection of the calibrators used in optical interferometry, and a client-side tool to
select a subset of this catalog for particular observing purposes. This tool is not restricted to a particular
spectral band, and can be used from the visible (V band) to the mid-infrared (N band). The strategy for the
selection of potential interferometric calibrator is based on the gathering of a large set of information from
the VizieR astronomical catalogs & SIMBAD querying services hosted at CDS. Those data are primarily
used to determine several angular diameter estimates of the sources. Based on some criteria concerning
the visibility of the sources for a given wavelength and projected baseline, and also the consistency of
the diameter estimates, the user can then decide whether each proposed star can be considered as a good
calibrator or not. SearchCal also provides some insights to help detect multiple, variable or complex sources.

The software has been completely rewritten in 2015-2016 following the new approach described in a
paper by Chelli et al., see http://simbad.u-strasbg.fr/simbad/sim-ref?bibcode=2016A\&A...589A.
112C. This new approach permits not only a much larger amount of candidate calibrator sources (up to
2.5million), but also an improvement in accuracy for the estimated diameters. The present documentation
has been thus completely rewritten.

1.3 Disclaimer

We warn the user that the sources provided by SearchCal do not come from observing program dedicated
catalogs, and therefore are NOT fully guaranteed. SearchCal proposes a selection of sources with the
highest possible probability to be good calibrators, but this do not prevent the user from an inspection
of the literature concerning the sources resulting from the search. In particular, it is notorious that the
fraction of sources with detected companions increases at fast rate, implying that the catalogs consulted are
not necessarily up to date in this regard at the time of query. Finally, we remind that the method employed
is statistical, i.e. a few individual stars may have a quite different diameter than expected (3σ ' 97%).

1.4 Installation

Availability SearchCal is freely available for download on the JMMC website at http://www.jmmc.fr/
searchcal.

Requirements SearchCal is based on Java 6 or greater, so your computer must have it installed (see
http://www.jmmc.fr/apps.htm for more details). An Internet connection is only required to get calibrators
from SearchCal servers at JMMC.

1.5 Acknowledgments

As with all other JMMC software, you shall acknowledge SearchCal usage if it was of any help in your
research. See section 3.6 for more details.
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SearchCal itself is based on multiple Open Source libraries and public services. We would like to thank:

• CDS, especially for their great VizieR and SIMBAD services without which SearchCal wouldn’t have
been possible, and their SAVOT VOTable parser which is at the core of SearchCal graphical interface;

• Mark Taylor of Bristol University in England, for its huge commitment to ease astronomers everyday
life with such great tools as TOPCAT and STILTS, or its essential jSAMP library enabling easy yet
reliable inter-application data exchanges;

• JMCS, the core JMMC graphical interface library, providing lots of missing stuff in Java, either
developed internally or by incorporating third-party libraries, to help our end-users feel right at home
using our apps.

1.6 Method

The method is described in a paper by Chelli et al., see http://simbad.u-strasbg.fr/simbad/sim-ref?
bibcode=2016A\&A...589A.112C. This method permits to estimate with a precision of a few milliarcsecs
(mas) the Limb-Darkened (angular) Diameter (LDD) of a star when its V,J,H,K photometry and spectral
type are known. This leads to produce a catalog of 450 000 angular diameters, the JSDC version 2 hosted
at CDS (http://cdsarc.u-strasbg.fr/viz-bin/Cat?II/346).

The SearchCal client interface is able to browse in this catalog, which is selected using the BRIGHT
search mode, and in an additional “myopic” catalog of ∼ 2 000 000 other fainter stars where the SearchCal
server has “guessed” the spectral type, available using the FAINT search mode.

Both the JSDC catalog and the SearchCal client show additional information, such as Uniform Diameters
(UDD). The conversion from LDD to UDD in each spectral band is made using mainly the coefficients
from http://vizier.u-strasbg.fr/viz-bin/VizieR?-source=J/A%2bA/556/A86/table16 and http://
vizier.u-strasbg.fr/viz-bin/VizieR?-source=J/A%2bA/554/A98/table16 when possible (compatible
spectral types) and following the prescriptions of the JMMC report at http://www.mariotti.fr/doc/
approved/JMMC-MEM-2610-0001.pdf in all other cases. The errors on UDD values are omitted as they are
similar to the estimated LDD error.

The SearchCal client displays results matching the request by selecting the targets in the BRIGHT
catalog or the FAINT extension according to the search criteria, namely the maximum distance from the
science target, within the magnitude range and observing band. Many filters, some selected by default
depending on the observing band, are available to sort among the (now quite large) number of calibrator
candidates.

For each star, the squared visibility (V2
cal, ∆V2

cal) is dynamically computed as function of the angular
diameter (UD), current wavelength and maximum baseline defined in the SearchCal client.

1.6.1 Further selecting calibrators

It is possible, once the list of potential calibrators has been retrieved, to refine the choice of the calibrators
using several selection criteria:

• field size around the science object

• calibrator maximum magnitude

• spectral type and luminosity class

• minimum value of the visibility

• accuracy on the visibility

• information regarding the potential calibrator variability and multiplicity (e.g., to avoid close, or
spectroscopic, binaries)
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• suspicious object type (SIMBAD)

• diameter estimation quality (maximum dispersion or relative error)

2 How to use SearchCal

In Fig. 1 the main window of the SearchCal client is shown. This window consists in three sections from top
to bottom, the Query Parameters panel, the Found Calibrators panel showing the result of the query and
the Filters panel enabling a refinement of the calibrator selection based on various filters and parameters.

2.1 Query setup

The Query Parameters panel shows three sub-sections from left to right:

The Instrumental Configuration section first allows one to select the observing Magnitude Band and the
Wavelength (by default the standard wavelength of the photometric band). The Max. Baseline length of
the observing baseline must also be provided. The Wavelength and Max. Baseline parameters are used
only by the SearchCal client interface to dynamically compute the square visibility, so you can adjust the
baseline length and see its impact on calibrator candidates.

The Science Object section shows the parameters describing the star you want to observe. Its position
(RA, DEC) and magnitude for the selected photometric band (which are mandatory for the request) can
be either manually entered, or automatically retrieved over the Internet using the ’rounded-corner’ search
field. Simply enter its name or any identifier (the syntax must follow the rules used for Simbad) to get those
values from the Simbad service hosted at CDS.

The SearchCal Parameters section allows one to specify the magnitude range in the selected photometric
band, and the sky field in which the calibrators will be searched. The user selects the search algorithm
among Bright and Faint modes:

• In the Bright case (few, on average brighter, stars with known spectral type) the research field is a
rectangular box, with a maximum size of 240.0min (60◦) in Right Ascension and 30.0◦ in Declination.

• In the Faint case (all 2.5 million stars) the research field needed is just a small circular patch of
typically a dozen arc minutes, with a maximum radius of 3600 arcmin (60◦).

2.2 Results browsing

Once the user filled the Query Parameters panel, the request is sent by clicking the Get Calibrators
button or menu.

The Found Calibrators panel shows the list of the calibrators with default filters applied (checked
boxes in the filter list). A minimalist set of columns is shown by default to better summarize calibrator
characteristics. But the user can also choose to see a more detailed view for each calibrator by opening the
Calibrators menu and selecting Result Verbosity : detailed. But there is even more data available by
using the Full verbosity for advanced users.

The default order of each column sets can be changed using the Preferences window. By clicking and
dragging any column header, it is also possible to temporarily personalize their order. Moreover, by clicking
on column headers, the result table is sorted out following the increasing value of the parameter. A second
click on the column header reverse the sorting order to decreasing mode.

Please note that the first (when ordered by distance) row may appear in bold face if it contains the
science object (i.e its distance is less than 1 mas). This only happens if the science object is also a potential
calibrator, so SearchCal was able to harvest data about it.

By using the Show Legend menu item in the Calibrators menu, the Legend sub-panel opens on the
right side of the Found Calibrators panel. The various colors identify the origin of each cell value. The
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Figure 1: Main Window
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description of each catalog is directly available in the Vizier service at CDS by clicking their name. The
lower part of the Legend sub-panel contains a color description indicative of the confidence of computed
values: LOW, MEDIUM or HIGH.

For each calibrator found, the user can easily go to the corresponding Vizier entry at CDS by clicking
on any calibrator identifier shown in the HD, HIP or 2MASS columns.

2.3 Further filtering

The Filters panel allows the user to dynamically refine the list of calibrators, without any loss of data nor
further query to CDS. Each filter is individually enabled or disabled using its left-most checkbox. Here is
the list of selection criterion applicable on the current result set, from top to bottom:

• The first criterion rejects sources farther from the Science Object than the indicated maximum R.A.
and DEC values.

• Then follows a criterion based on the magnitude to define the faintest calibrator allowed.

• The following criteria defines the spectral types and luminosity classes to reject.

• The next criterion sets the minimum squared visibility allowed. This is a key criterion to select
interferometric calibrators at a given baseline, since good calibrators are expected to have squared
visibilities as close as possible to 1.0.

• Similarly, follows a criterion to set the maximum estimated error on the squared visibility allowed.
This criterion is an indirect information on the quality of the calibrator. Please note however that
such an estimate is difficult to evaluate, and this criterion should be used with caution.

• The variability criterion works on data collected from the I/280 (All-sky Compiled Catalogue, Kharchenko
2001) catalogue. If any of the variability flag columns means variability suspicion, the source is rejected.

• The next criterion is all about sources multiplicity. It rejects stars known as either a spectroscopic
binary in the SBC9 catalogue (Pourbaix et al., 2004), or as a visual binary in the WDS catalogue
(Mason et al., 2001) where sep1 <2” or sep2 <2”.

• The next criterion uses SIMBAD object types to reject ”invalid” sources (Algol, Mira, rapid rotators
...& candidates) that should not be considered as good calibrators.

• The final criterion operates on the diameter estimation quality to define the upper limit on either the
diameter dispersion (chi square) or the relative error of the mean diameter (LDD).

2.4 Examples

On first launch, SearchCal loads with default querying parameters. You can simply press the Get Calibrators
button to start a first demonstration query. In the following section, we provide you with more example of
usage if needed.

2.4.1 Bright Query

Here is a set of parameters to input in the Query Parameters panel to do your first bright calibrator
research:

• Magnitude Band : select ”K” in the popup menu;

• Wavelength : type ”2.2” (without quotes);

• Max. Baseline : type ”102.45” (without quotes);
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• Name : type ”Alpha Cen” (without quotes), then enter to automatically fulfill coordinates and magni-
tudes;

• Min. Magnitude : type ”-1” (without quotes);

• Max. Magnitude : type ”4” (without quotes);

• Scenario : click on the ”Bright” radio button;

• RA Range : type ”60” (without quotes);

• DEC Range : type ”10” (without quotes);

All mandatory parameters are now defined. Then click on the Get Calibrators button to launch the
search. After a while (the progress bar gives you the status of the currently running query), your results
appear in the Found Calibrators pane. You can now filter your results using the Filters panel, by:

• Luminosity Classes : enable this filter (by clicking on its left-most checkbox), then click on the ”V”
checkbox to hide calibrators belonging to the ”V” luminosity class group;

• Spectral Types : enable this filter (by clicking on its left-most checkbox), then click on the ”G”
checkbox to hide calibrators belonging to the ”G” spectral type group.

2.4.2 Faint Query

Here is a set of parameters to input in the Query Parameters panel to do your first faint calibrator research:

• Magnitude Band : select ”K” in the popup menu;

• Wavelength : type ”2.2” (without quotes);

• Max. Baseline : type ”102.45” (without quotes);

• Name : type ”Tau Boo” (without quotes), then enter to automatically fulfill coordinates and magni-
tudes;

• Min. Magnitude : type ”4” (without quotes);

• Max. Magnitude : type ”8” (without quotes);

• Scenario : click on the ”Faint” radio button;

• Radius : type ”60.0” (without quotes);

All mandatory parameters are now defined. Then click on the Get Calibrators button to launch the
search. After a while (the progress bar gives you the status of the currently running query), your results
appear in the Found Calibrators panel. You can now filter these results using the Filters pane, by:

• Magnitudes : enable this filter (by clicking on its left-most checkbox), then type ”7” (without quotes)
to hide calibrators whose magnitude is greater than 7;

• Multiplicity : disable this filter (by clicking on its left-most checkbox), to show calibrators potentially
composed of multiple sources (as spectral binaries, ...).
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3 Menu Bar walkthrough

SearchCal top main menu bar contains the following entries:

File : to open and save the results of your queries.

Edit : to cut and paste, find any value and change the preferences of SearchCal.

Query : to reset or change the default values of the query panel.

Calibrators : to determine the level of details of the calibrators panel.

Interop : to share SearchCal results with other VO-compliant applications like ASPRO2 or Aladin.

Help : contains the information about SearchCal, plus means to communicate with us.

3.1 File menu

The File menu provides the user with the ability to load, save, print, and export its calibrator list.
SearchCal native file format is VOTable-compliant. IVOA described VOTable format as an XML stan-
dard for the interchange of data represented as a set of tables. VOTable is a flexible storage and exchange
format for tabular data, with particular emphasis on astronomical tables. This file format advantage is its
interoperability with (i.e its ability to be opened by) lots of VO-compliant tools, like TOPCAT, Aladin,
... SearchCal VOTable file type is *.scvot. Any VO-compliant software can open SearchCal files. On the
other hand, as SearchCal stores lots more than raw values in its files, it only understands its very own
*.scvot VOTables, but does not support opening of general purpose VOTables.

The Open menu loads calibrator lists previously saved by SearchCal in the *.scvot VOTable file format.

The Save and Save As... menus can save fetched calibrator lists in the VOTable-compliant *.scvot
SearchCal file format.

The Revert to Saved menu reloads the current calibrator list in its previously saved state, thus losing any
modification made in between.

The Export to CSV... menu writes the current calibrator list in “comma-separated values” file format,
compatible for example with OpenOffice (or any other modern data analysis application).

The Export to HTML... menu writes the current calibrator list in HTML, for Web publication or presen-
tation.

3.2 Edit menu

The Edit menu is mostly standard, providing you with widely expected copy-pasting and deletion function-
alities. It also features find capabilities, to search specific values within the calibrator list.

The Find sub-menu offers standard search functions, such as defining the desired token (either in simple or
regexp format) in the Find window with Find..., jumping to the next token occurrence with Find Next,
or going backward with Find Previous.

The Delete menu item allows you to hide currently selected calibrators from result list.

The Undelete menu restore all previously deleted calibrators.

The Preferences... menu shows you the application setting window as expected.
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3.3 Query menu

The Query menu provides options dealing with Query Parameters panel.

The Reset Values menu blanks all Query Parameters panel fields.

The Load Default Values menu restores all parameters to their previously saved states (or factory defaults
if none).

The Save Values as Default menu puts all current parameters values as preferences, so as to be auto-
matically retrieved each time you launch SearchCal.

3.4 Calibrators menu

The Calibrators menu deals with Found Calibrators panel configuration.

The Results Verbosity sub-menu offers several levels of detail among Synthetic, Detailed and Full.
Each of those levels corresponds to a different extended set of columns according to the instrument band
and the Bright / Faint search mode, providing you with more information for each calibrator in the list.

The Show Legend menu shows a dedicated panel on the right of the calibrator list, explaining you the
meaning of colors used in each list cells.

The Get Calibrators menu launches the query to populate the result list.

3.5 Interop menu

The Interop menu allows to share SearchCal calibrator list (or selection) with other VO-compatible tools
through SAMP (see http://www.ivoa.net/cgi-bin/twiki/bin/view/IVOA/SampSoftware for the official
list). SAMP relies on a hub-based architecture, to which every compatible software register, in order to
facilitate inter-process communication and discovery.

The (Un)register Hub menu can be used to (dis)connect SearchCal to/from SAMP hub. If no hub found,
SearchCal will start one automatically.

The Show Hub Status displays SAMP hub control window, mainly for debugging purpose.

The Send Calibrators to menu sends current calibrator list or sub-selection to other VO tools (only
available if compatible software able to handle VOTable is registered to the SAMP hub, e.g ASPRO2,
Aladin, TOPCAT, or any other tool able to open VOTables through SAMP).

3.6 Help menu

The Help menu is an important tool to get information about our software, but also to communicate with
us.

The User Manual menu allows you to browse SearchCal user documentation right from within the appli-
cation. You can hierarchically browse the manual, or search through it.

The Report Feedback to JMMC... menu allows you to provide us with any comment, enhancement request
or encountered problem. Please, carefully select the type of comment, as they are addressed to different
persons across our teams. The user mail is an OPTIONAL entry, but is needed if you expect any feedback
from us regarding your remark. If you fill it once, it will be remembered later on.

The Copy Acknowledgment to Clipboard menu puts the SearchCal acknowledgment sentence and Bibtex
entry in your pasteboard, so you can easily paste it into the reference list of your papers that made use of
SearchCal in any means.

The Hot News (RSS Feed) menu opens your default Web browser on a page listing all events concerning
SearchCal.
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The Release Notes menu opens your default Web browser on a page reporting the last releases and changes
of SearchCal.

The Frequently Asked Questions menu opens your default Web browser on the SearchCal FAQ web
page.

4 Preferences Window functionalities

The window panes shown in Fig. 2 allow you to customize the default behaviour of SearchCal to better
fit your needs. Any change you do is for the current run of SearchCal only, until you press the Save
Modification button. This will write your current configuration settings to file, in order to be restored later
when you launch SearchCal. You can of course revert to factory settings at any moment, using the Restore
Default Settings button. But be warned that this will definitively erase any previous configuration done,
including your default query parameters values (if any).

4.1 Columns Order setup

This panel allows you to change the default columns order for each possible configuration (bright/faint,
magnitude band). By selecting the desired configuration, then selecting the column to move, you can
change its position using the Up and Down buttons, and dynamically watch the modification in your current
calibrator list (if the same view is currently shown).

4.2 Legend Colors customization

This panel allows you to change the colors used to show you the origin and confidence of the data in the
calibrator list. By clicking each row, you can then choose a new color as desired, and dynamically watch
the modification in your current calibrator list as well.

4.3 Help Settings definition

This panel allows you to define our various help functions default behaviours.

The Results Verbosity radio buttons set the desired detail level used to display SearchCal calibrator
results by default, among Synthetic, Detailed and Full.

The Show Legend enables or disables the default display of the legend view.

The Show Tooltips enables or disables the contextual help balloons shown while approaching your mouse
pointer to some widgets (as calibrator list cells, buttons, ...).
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Figure 2: Preferences Window Panes

Revision: 7.0 Page 14/14


	1 Introduction
	1.1 Abbreviations and acronyms
	1.2 Presentation
	1.3 Disclaimer
	1.4 Installation
	1.5 Acknowledgments
	1.6 Method
	1.6.1 Further selecting calibrators


	2 How to use SearchCal
	2.1 Query setup
	2.2 Results browsing
	2.3 Further filtering
	2.4 Examples
	2.4.1 Bright Query
	2.4.2 Faint Query


	3 Menu Bar walkthrough
	3.1 File menu
	3.2 Edit menu
	3.3 Query menu
	3.4 Calibrators menu
	3.5 Interop menu
	3.6 Help menu 

	4 Preferences Window functionalities
	4.1 Columns Order setup
	4.2 Legend Colors customization
	4.3 Help Settings definition


